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 Overview
Spb Imageer is a very powerful imaging engine designed specifically to streamline common 
processes that Pocket PC users perform with digital photos. Equipped with an incredibly rich 
set of features, Spb Imageer will make your work with images fast, comfortable and joyful. 

Software Features

One-click slideshow 
Tap on the slideshow button to quickly start showing off your photos to family and friends. 
Slideshow preferences include settings for the delay between photos, rotating them as 
needed, looping the show, and choosing from 22 different effects with smooth transitions.

Multiple thumbnail options
In the detailed thumbnail mode you can see thumbnails and the information on the image 
files: name, time and date of creation, size in bytes and size in pixels, along with the ability 
to quickly open the image properties dialog.

Picture editing 
The most frequently used editor actions such as brightness, contrast, auto-level, crop, anti 
red-eye, and more are available from the Edit toolbar. 

Storage card notification with common tasks
When you insert a storage card into your device with any photos on it, the storage card 
notification window will appear with 6 options to choose from. You can choose to View 
Slideshow, Browse Pictures, Optimize and Save to Folder, Create an Album, Publish to the 
Web, or Open in File Explorer. In order to use this feature you need to enable it from Spb 
Imageer options.

Batch optimizing of photos
Images stored on your Pocket PC might be far from optimal. It does not make sense to keep 
large images, which will be shown small on a Pocket PC screen. Instead, you can optimize 
images for the best storage and usage on your Pocket PC.

The optimization process comes with the following processes:

• Optimize and Create Album Wizard

• Optimize and Save to Folder Wizard

• Optimize and Publish to Web Wizard

• Copying images from a desktop computer

• Adding a picture to an existing album

Web publishing
Share your images with family and friends by publishing right from your Pocket PC to a 
website. Select the photo(s) you want to publish and optimize them for publishing using a 
wizard in six easy steps.. The images are published to the Flickr Photos, Fotki.com, Foto 
Quelle. 
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Album Creation and Sharing
Do you want to quickly take out your Pocket PC to show off your pictures of last week 
events to your friends or family? Spb Imageer album is a single file that contains your 
optimized pictures slideshow ready in one tap. The Album provides quick access to your 
pictures for showing them on your Pocket PC. 

Rich Picture Notes 
There are three types of notes you can attach to your images text notes, audio notes, and 
drawings. You can use this powerful tool to make your images come alive. 

Powerful Screenshot Tool
Spb Screenshot maker is a tool for screen captures. Screenshot images can be in BMP or 
PNG format. It helps you to build professional screenshots.
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Installation
The installation of Spb Imageer is a very simple process and takes less than five minutes to 
complete. The following installation guide will help you.

System Requirements
Make sure your system meets the following minimum requirements before 
installation:

Windows Mobile 2003, Windows Mobile 5, Windows Mobile 6 Professional or 
Classic.

Installing  
After you have downloaded the Spb Imageer distribution file you should install it to your 
device. For a successful installation you will need a Pocket PC device attached to your 
Windows desktop PC. You will also need Microsoft ActiveSync software in order to install 
Spb Imager to your device.

When you run the software installer on your desktop PC it will ask you to accept the license 
agreement and will start the installation program. You will be prompted for the location 
where you want the software to be installed. You will also be prompted to install the 
ActiveSync filter. If you have a digital camera and want to insert your external storage card 
and use Spb Imageer, then you should install Spb Imageer on the device in main memory.

Note: Microsoft ActiveSync works only with Windows XP SP2 or earlier. If you have 
Windows Vista, your synchronization settings will be managed through the Windows Mobile 
Device Center. Windows Mobile Device Center is available through the Windows Mobile 
Device Center page.

Registration 
You will be able to use Spb Imageer until the end of the trial version period of 15 days from 
the first installation. If you have not registered Spb Imageer within this timeframe, you will 
need to do so to continue using it. 

To obtain the serial number you need to purchase an Spb Imageer software license. You will 
receive your serial number by e-mail.

Uninstalling
To remove the product from your Pocket PC:

1. Go to Start menu > Settings

2. Open System and tap on Remove Programs

3. Select Spb Imageer from the list and tap on the Remove button

4. Choose Yes to confirm removing
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Configuring Spb Imageer
After Spb Imageer is installed on your Pocket PC it is ready to use. You can now customize 
the settings and behavior(s).

Spb Imageer Options
You may customize Spb Imageer to fit your needs. To begin go to the main menu and select 
the Options… menu item. The Options screen includes the following tabs which you can 
use to adjust your settings: 

Picture 
There are some common picture options you can customize. 

• Open pictures in full screen mode: If this 
option is enabled, all the pictures opened from the 
image list   are displayed in full screen mode by 
default.

• Optimize pictures for 12 bit devices: If your 
device does not support 16 bit color pictures (very 
few old devices) it may essentially distort colors. In 
order to prevent pictures from being shown with 
stepped color changing the smooth algorithm is 
implemented. Select this option to apply this 
algorithm.

• Never show icon in full screen mode: If you 
tap the screen in full screen mode a small icon 
button appears for a few seconds in the low left 
corner to quit the full screen mode when tapped. 
However you can disable this button by enabling this option. When you want to 
return to the regular viewing mode simply double-tap the image.

• "Rotate if Needed" direction: Choose, in which direction (right or left) images 
will be rotated if the 'Rotate if Needed' mode is on.

• Pre-load next picture: Spb Imageer will automatically load the next image into 
memory while the current one is being displayed. This will provide faster image 
loading when viewing several pictures in sequence.

File List
Here you can configure the file list view options.

• Show filenames extension: Enable the display of the extension of the graphic 
file along with the file name in the image list.

• Include storage card subfolders: If enabled, Spb Imageer will display all 
images found on a storage card(s) at once in an image list. If not, you will have 
to open every folder to see the contents.

• Hide pictures stored in ROM: Enable this option to prevent pictures stored in 
ROM from being displayed and added to your image list. The ROM includes many 
system images that you may not want to view.
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• Show storage card notification: If enabled, you 
will receive a notification window every time you 
insert a storage card into your device with any 
photos on it. The notification window gives you 6 
options. You can choose to View a Slideshow, 
Browse Pictures, Optimize and Save to Folder, 
Create an Album, Publish to the Web, or Open in 
File Explorer. After a few seconds the window will 
minimize if you do not take any action. You can 
tap the storage card icon on your top toolbar to 
open the choices list again.

• Enlarged thumbnails: If selected, the thumbnails 
will be cropped to cover more area in thumbnail 
view mode.

• Use soft-keys style menu: Enable or disable the 
soft-keys menu style instead of the button toolbar.

Slideshow
The slideshow mode has the following parameters to 
customize:

• Rotate if Needed: Select to apply the 'Rotate if 
Needed' mode to images shown in slideshow 
mode.

• Loop: Select to loop the image show in slideshow 
mode.

• Delay: Provide the desired delay time.

• Effect: Select the desired image view effect. Look 
at the sample preview to see the effect result.

Notes
Here you can configure your notes options.

• Display text notes: Enable to display the text notes along with images. 

• Show file name when text note is absent: 
When enabled, the image file name will be 
displayed if there is no text note provided. The file 
name font will be formatted accordingly to the 
Default font preferences for text notes.

• Display drawings: Enable this option to display 
drawings, if any, on images.

• Play audio notes: Enable this option to play the 
audio file that has been added to a photo in the 
photo view.

• Never display file name in slideshow: Enable 
or disable the display of the image file name in the 
slideshow.
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• Text Notes Settings: Tap this button to 
customize the default text note font, size, position, 
and appearance.

Note: If you remove any of these selections, the created 
text, drawing, or audio notes will still exist, but will not be 
displayed (played) along with images.

Edit
The edit tab has the following parameters to customize:

• Preserve EXIF information: Some image files 
may contain additional information, called Exif, an 
exchangeable jpeg-encoded image file format. 
Many digital cameras add this information to 
photos they produce. When this option is enabled 
the Exif information will be kept after any image 
editing.

• Jpeg saving quality: Move the slide-bar to 
choose the desired JPEG saving quality coefficient. 
This quality will be applied when saving an image 
after editing. Better quality results a bigger file size 
and vice versa.

Web
Here you can customize publishing to the web options. 

• Site: Select where your photos will be published 
to. You have three websites to choose from Flickr 
Photos, Fotki.com, or Foto Quelle.

• User Information: Here you can see your 
registration information for the selected website. 
Tap on the Register button to automatically open 
the registration webpage to set your free account 
user name and password.

• Open Flickr Photos in web-browser: Tap on Flickr Photos to open the Flickr 
website in the Pocket Internet Explorer.

Note: An Internet connection is required for the registration 
process. 

Associations
You may assign some types of image files to be opened with 
Spb Imageer when they are tapped in File Explorer. Select 
the corresponding check boxes.

Note: Spb Imageer does show all supported image files. In 
these options you can only set which image files to be opened 
with Spb Imageer.
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Spb Screenshot Tool Options
Spb Screenshot maker is a standalone application for screen 
capturing. To open its options you need first to run the 
application which you can find in the Programs. After you 
open it select Settings… from the main menu.

•  Assign screenshot to button: Assign your 
device hardware button (ok button, camera, or 
voice recorder) to capture your device screen with 
one press on the assigned button. Tap on the 
Reassign button and press on the hardware key 
that you would like to assign. In the text box you 
will see the assigned hardware key name.

• Delay before making screenshot: Select to 
defer taking the screenshot after pressing the 
assigned hardware key. Choose the delay time 
from the dropdown list below.

• Save to: Select the storage folder for the taken screenshots.

• Output file name and format: You can set a name for the screenshots. For 
example if you set the name to “Screen”, the second screenshot will 
automatically have the name “Screen1” then “Screen2” for the next screenshot 
and so on. You can also select the format of the image file either PNG or BMP. 
The Portable Network Graphics format (PNG) will take less storage space than the 
BMP format.
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Using Spb Imageer
Spb Imageer has easy to use functions and tools. This chapter contains all the information 
you will need to be able to use all of the Spb Imageer powerful features. 

Image List
In the main Spb Imageer window you can see all of the 
pictures in the My Pictures folder. This view can be changed 
from the Menu > View > File List submenu to thumbnails, 
detailed thumbnails view, or a simple list. You can also start a 
slideshow and open the photo’s properties.

The main window has a built-in file browser to quickly find 
any pictures you may have on your device.

• Tap the Up softkey to go up in the folders 
hierarchy. 

• Tap on the upper left Show menu (current folder 
by default) to browse your device for pictures. 

• Tap on the upper right Sort By menu (Name by 
default) to arrange your pictures according to name, 
date, size, or type.

The main Menu allows you to create a new folder, create an album, publish to the Web, 
access the options settings, and register the product. 

Tapping and holding on the photo, album, or folder brings up many useful commands in its 
context menu. Tapping on a photo opens the Image View screen.

Image View
Spb Imageer opens pictures according to predefined 
preferences. If your picture is opened in the full screen mode 
then double-tap or press the Action hardware button on it to 
return to the image view.

There are several zoom levels, rotation choices, go to the 
next/previous image, start slideshow, and open image 
properties in the View menu 

The main Menu allows you to save as, delete, add note, 
open the editing mode, access the options, and register the 
product. 

When the displayed picture is larger than the screen area, 
you can scroll it in any direction using your stylus.
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Notes Mode
When you tap the Note button, the Notes toolbar is 
displayed. Left to right on this toolbar is: Notes menu, Add 
Text button, Add Drawings button, and Voice Recording 
button. From the Notes menu you can remove any added 
notes and play the recorded audio file. 

• With the Add Text button, you can add a text 
comment to the top or bottom of your photo. Just 
select the color and font style for the displayed 
text, or use the default setting (see notes options).

• With the Drawing button, you can draw sketches. 
Use the drawing toolbar to change the line width 
and color, undo draw button, repeat draw button, 
done button, and cancel button.

• With the Voice Recording button you can add an 
audio file to be played when displaying the photo. You can start recording, stop, 
or play recorded audio file using the record toolbar.  

Once text comments, sketches, or voice records have been added to a photo, these will 
display or play in the main picture view (unless you disable the corresponding options). 
Added notes will display/play during slideshow playback as well.

Edit Mode
Spb Imageer allows you to edit your images. Following is the list of available editor actions 
and commands:

From the Edit menu you can undo, redo, resize, rotate, filter, 
colors adjustment, return to the last saved edited picture, 
and save a copy of the edited picture.

• Crop: By tapping this button, you can crop a 
rectangular area of a currently displayed image 
and make a separate image out of it. Move your 
stylus over the image to select a desired area. You 
will be asked to tap somewhere inside the selected 
area to finish. The selected area will appear as a 
new image. Later you can save it in a separate file.

• Anti Red-Eye: Tap this button to remove red eye 
on photos.

• Brightness, Contrast: Customize these parameters 
manually or select the Auto-level command to 
provide considerable improvement of picture 
quality, especially for digitalized photos.

After you have finished editing, tap Save to save the changes you applied to the picture or 
select Edit > Save as... to save as a new picture and keep the original photo unchanged. 
Otherwise, tap Cancel.
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Create an Album…
Spb Imageer album is a single file that contains your edited 
pictures in the order you want, with notes, and slideshow 
ready. In the Image List view select Create an album… 
from the main menu to start the album wizard. Optimize and 
Save to Album steps are:

• Select the desired images; they are all displayed as 
thumbnails. Tap the Next button when finished to 
continue.

• Specify the size of the processed images. You may 
leave them in the original size, select one of 
predefined ones, or use a custom variant. Tap the 
Next button when finished to continue.

Note: any selected size will be applied to ALL pictures.

• Adjust parameters such as brightness and contrast. 

o Original Brightness and Contrast: These 
parameters won't be changed.

o Auto Brightness and Contrast: The best 
brightness and contrast combination will be 
applied to all pictures.

o Custom Brightness and Contrast: Here you 
can customize brightness and contrast 
manually. Move the corresponding sliders and 
see the result on a displayed picture. 

To view other images of the selection, tap on the left 
or right arrow. Tap the Next button when finished to 
continue.

• This wizard page deals with image rotation and 
crop settings. If you select Rotate right if 
needed, then the pictures, the height of which is less than their width, will be 
rotated right. Select No Rotation to prevent any 
rotation. When the height and width of an image 
are not proportional to the desired size you may 
select Crop picture to fit best and the program 
will crop the middle part of an image to fulfill a 
certain area. Some areas of a picture will be lost. 
Otherwise, leave this checkbox unselected. Tap the 
Next button when finished to continue.

• This page deals with image naming and saving 
settings. 

o Rename pictures: Select a desired renaming 
scenario:

 Do Not Rename Picture: keeps the 
original picture name.
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 Add Current Date Prefix: adds the current date to the original 
picture name.

 Add Current Date Prefix and Renumber: removes the original 
picture name, adds the current date and a number (1,2,3...).

 Add Custom Prefix: adds a custom prefix (specified below) to the 
original picture name.

 Add Custom Prefix and Renumber: removes the original picture 
name, adds a custom prefix (specified below) and a number (1,2,3...).

• Here you can provide the album name and the storage folder. Tap the Next 
button to continue.

• Customize the optimized JPEG images quality. Move the JPEG quality slide bar to 
set the desired value. Higher quality provides bigger size/slower loading and vice 
versa. Tap the Next button to start the process.

Later on you can add more pictures to the created album. To do this, copy one or more 
pictures, then browse an existing album and paste them into it. The Create Album wizard 
will open automatically and you will be able to optimize the selected images and add them 
to this album.

Publish to the Web Wizard
After you select the Publish to Web… option from the main menu in the Image List view 
you will go through a 6-step wizard that optimizes the photos for publishing. The images will 
be published to the Flickr Photos, Fotki.com, or Foto Quelle websites. The first time you will 
be prompted to set up a free account right from your Pocket PC.

• Select the desired images; they are all displayed as thumbnails. Tap the Next button 
when finished to continue.

• Specify the size of the processed images. You may leave them in the original 
size,   select one of predefined ones, or use a custom variant. Tap the Next 
button when finished to continue.

Note: any selected size will be applied to ALL pictures.

• Adjust such parameters as brightness and contrast. 

o Original Brightness and Contrast: These parameters won't be changed.

o Auto Brightness and Contrast: The best brightness and contrast 
combination will be applied to all pictures.

o Custom Brightness and Contrast: Here you can customize brightness and 
contrast manually. Move the corresponding sliders and see the result on a 
displayed picture. 

To view other images of the selection, tap the left or right arrow. Tap the Next 
button when finished to continue.

• This wizard page deals with image rotation and crop settings. If you select 
Rotate right if needed, then the pictures, the height of which is less than their 
width, will be rotated right. Select No Rotation to prevent any rotation. When 
the height and width of an image are not proportional to the desired size you 
may select Crop picture to fit best and the program will crop the middle part of 
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an image to fulfill a certain area. Some area of a picture will be lost. Otherwise, 
leave this checkbox unselected. Tap the Next button when finished to continue.

• This page deals with image renaming and saving settings. 

o Rename pictures: Select a desired renaming scenario:

 Do Not Rename Picture: keeps the original picture name.

 Add Current Date Prefix: adds the current date to the original 
picture name.

 Add Current Date Prefix and Renumber: removes the original 
picture name, adds the current date and a number (1,2,3...).

 Add Custom Prefix: adds a custom prefix (specified below) to the 
original picture name.

 Add Custom Prefix and Renumber: removes the original picture 
name, adds a custom prefix (specified below) and a number (1,2,3...).

• Here you can select the website (Flickr Photos, Fotki.com, Foto Quelle) to upload 
your photos and provide the album name if you 
prefer to. Tap the Next button to continue.

• Customize the optimized JPEG images quality. 
Move the JPEG quality slide bar to set the desired 
value. Higher quality provides bigger size/slower 
loading and vice versa. Tap the Next button to 
start the process. The program will connect to the 
server and upload the photos according to the 
defined options. An Internet connection is required.

Note: You need to obtain an account for the selected website 
before uploading the photos. If you start publishing to the 
web wizard without having an account you will be redirected 
to the registration webpage to set your free account user 
name and password. See the Web options for more details.
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Technical Support
This chapter contains technical support information. It includes all the information you need 
to assist you.

About the Trial Version
The trial version of Spb Imageer includes all of the features available in the registered 
version. The trial version expires within 15 days after the first installation. You can use the 
trial version only to check how Spb Imageer works. In order to keep using the software you 
need to purchase the license. There is no need to re-install the Spb Imageer in order to use 
the full version.

To obtain the serial number you need to purchase Spb Imageer software license. You will 
receive your serial number by e-mail. For more information please visit our web site at: 
http://www.spbsoftwarehouse.com/products/imageer/support.html

 Contacting Technical Support
Please take advantage of one of the Spb Software House free technical support options:

• Consult the online help installed with your program. From any of Spb 
Imageer screens select Help menu item from the Start menu. 

• Refer to the Frequently Asked Questions (FAQs) in the Support section of 
the Spb Software House Web site. The FAQs may have information and 
helpful hints that are more current than the User Manual:
http://www.spbsoftwarehouse.com/products/imageer/faq.html

• Ask your technical question or post your feature request in the forum to 
get a quicker reply directly from the developer team or the user’s 
community. Solutions to your problems are available 24 hours a day at no 
cost on the Spb Club web site. You must first register as a member before 
using Spb Club web support: http://www.spbclub.com/forum/ 

Please include the following information to help us isolate the problem:

1. The type of the device that you are using. 

2. The software name and version number. Select Menu → About… to view the 
software name and version number (example: Spb Imageer, version 1.6, 
Build 707).

3. Any error messages that accompany the problem.

4. A brief description of how we can recreate the error.

5. Your name and the preferred contacting method.
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